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11.1. Računalniško podprto snovanje elektronskih naprav 
 

Računalniško podprto načrtovanje CAD ('Computer aided design')je uveljavljeno 
na mnogih industrijskih področjih. CAD načrtovanje pomeni, da v procesu snovanja 
uporabljamo orodja informacijskih tehnologij - IT.  CAD načrtovanje je sestavljeno iz 
strojnega dela ('Hardware'), specifične programske opreme ('Software') ter zunanjih 
naprav in vmesnikov. Jedro CAD načrtovanja je programski paket, ki uporablja grafiko za 
prikazovanje, različne podatkovne baze in gonilnike za periferen naprave. CAD snovanje 
ne spremeni postopka snovanja, ampak ga bistveno olajša ter pohitri. CAD orodja so zelo 
učinkovita predvsem pri snovanju naprav, ki morajo biti ekološko učinkovita. Mnoga 
orodja že vsebujejo pomagala, ki pomagajo analizirati ter ovrednotiti ekološko snovanje. 
Prav tako nekatera orodja vsebujejo podatkovne baze o elementih, materialih, ki so del 
snovanja. Če se vrnemo na bistvo CAD načrtovanja je vloga le teh navedena  v naslednjih 
alinejah, 

• Natančna grafična predstavitev izdelka. Prav tako je izdelek preprosteje 
analizirati, spreminjati ter nadgrajevati.  

• Omogočajo kompleksno snovanje v zelo kratkem času.  

• Omogočajo simulacijo različnih pojavo, kot so: električni, kemični, termični 
in mehanski.  

• S pomočjo simulacijskih orodij je možno preprosteje zagotoviti optimalni 
pristop k načrtovanju ter sam končni izdelek.  

Prva CAD orodja so bila razvita za namene vesoljske ter avtomobilske industrije. 
Nato se je razmah CAD orodij prenesel tudi na ostala inženirka področja kot so; 
elektronska, tekstilna industrija, pakiranje itd.. 

CAD orodja so prvotno namenjena za avtomatizacijo nekaterih snovalnih procesov 
ter modeliranja sistemov. Današnja CAD orodja podpirajo večino aktivnosti v fazi 
snovanja. Tako vsebujejo informacije o karakteristike izdelka in uporabljenih materialih. 
Prav tako CAD orodja služijo, kot skupna platforma za izmenjavo podatkov med 
različnimi načrtovalskimi skupinami in timi. CAD orodja lahko vsebujejo informacije o 
proizvodnji. Takšna orodja pogosto imenujemo CAD/CAM orodja ('Computer Aided 
Manufacturing'). Slika 1. prikazuje proces klasičnega in CAD/CAM snovanja. CAD orodje, 
kot smo že omenili skrajša čas snovanja, kar posledično pomeni, da je izdelek prej na 
trgu in razvoj izdelka je cenejši. Prav tako CAD orodja shranjujejo postopek snovanja, kar 
omogoča hitrejšo in lažjo nadgradnjo prvotne verzije. Slika 2. prikazuje povprečni čas 
snovanja produkta ter njegovo uporabo. Čim krajši je čas snovanja naprave tem daljši je 
čas uporabnosti naprave na trgu. Ta pogoj velja le če je snovanje izvedeno korektno.   
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Slika 1. Primer klasičnega in CAD/CAM snovanja. 

 

 

Slika 2. Povprečni čas snovanja ter uporabe produkta. 

 

V nadaljevanju poglavja se bomo lotili CAD orodij, ki so namenjeni za snovanje 
elektronskih naprav.  
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11.2.  Načrtovanje tiskanih vezij 
 

Načrtovanje tiskanih vezij-PCB ('Printed Circuit Board') pri snovanju elektronskih 
naprav je ključna naloga vsakega razvoja. Dobro načrtano vezje ter sama tiskanina vpliva 
tako na kvaliteto, kakor tudi zanesljivost naprave. S postopkov načrtovanja tiskanine 
določimo vse elemente ter velikost samega vezja. Pri izbiti komponent ter velikosti 
tiskanine lahko zadostimo mnogim ekološkim smernicam. Načeloma uporabimo 
komponente, ki so manjše, manj energijsko potratne ter načrtamo vezje, ki zavzame 
manj površine.  V današnjem času poznamo mnoge napredne tehnologije, ki omogočajo 
več plastne tiskanine. Več plastne tiskanine omogočajo manjšo površino vezja ter 
posledično nekoliko nižjo porabo materiala tiskanine. Po drugi strani se je potrebno 
zavedati, da je tehnologija izdelave bistveno dražja ter porabi več energije, kar pa je 
ekološko manj prijazno. Pri izdelavi tiskanine je tako potrebno najti kompromis med 
izbranimi elementi ter velikostjo tiskanine, ki imajo v fazi proizvodnje čim nižji ekološki 
vpliv. Kljub ekološkim vidikom je potrebno upoštevati določene smernice ter pravila 
snovanje tiskanine z namenom doseganja visoke zanesljivosti ter kvalitete tiskanine in s 
tem končne naprave.  

Standarde za načrtovanje tiskanine nadzoruje združenje IPC. IPC skrbi za 
standardizacijo izdelave tiskanih vezij ter uporabe materialov. Glavni dokument, ki 
pokriva načrtovanje tiskanih vezij je dokument ICP-2221-'Generic Standard on Printed 
Board Design'.  

Standardi koraki pri načrtovanju tiskanine so: 

• Specifikacija projekta. 

• Načrtovanje električne sheme. 

• Načrtovanje tiskanega vezja. 

• Prototipiranje 

• Testiranje 

• Proizvodnja 

Trenutno na trgu obstaja mnogo orodij, ki omogočajo načrtovanje tiskanih vezij. 
Našteli bomo le nekaj najpogosteje uporabljenih: 

• AutoTRAX (Sheme, PCB design z vgrajenim Spice simulatorjem) 

• Advanced Design System (Namenjen bolj RF elektroniki…mobilniki, wifi 
network, satelitski komunikaciji, radarjem, VF vezja…VF simulatorji)  

• Eagle (Sheme, PCB design, tudi zastonjska različica, za manjše projekte, 
akademske kroge, 3D pogled itd.)  

• Altium designer (nekdaj Protel, sheme, PCB, podpora za FPGA – 'Field 
Programmable gate array' in z zmožnostjo programiranja, prevajanja 
programske kode, 3D pogled)  

• OrCAD orodja( Sheme, PCB)  

• CADSTAR (sheme, diagrami, PCB, obstaja zastonjska verzija z osnovnimi 
funkcijami CADSTAR Express)  

• KICAD (Odprtokodno okolje, Sheme, PCB in 3D pogled ) 
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11.2.1 Načrtovanje električnih shem  

Pri načrtovanju električnih shem je pomembno, da je shema urejena, povezave 
so logične in čim manj križanja med seboj.  Prav tako je dobra shema načrtovana tako, 
da je zelo podobna tudi končni tiskanini. Na primer, če želimo blizu določene elektronske 
komponente kondenzator, ga tudi na shemi narišemo blizu simbola te komponente. 
Držimo se nepisanega pravila, vsi vhodi so na levi in vsi izhodi na desni strani sheme. Po 
potrebi se poslužujemo komentarjev ter opombo. Pri kompleksnih vezjih se za boljšo 
preglednost določijo področja sheme. Vsa področja sestavljajo celotno shemo naprave. 
Področja sheme so samo virtualni odseki sheme, ki zaokrožijo delno celoto vezja.  Na 
primer, napajalni del vezja rišemo posebej ali na določenem področju sheme. Prav tako 
krmilniški del načrtujemo v svojem področju itd.. Slika 3. klasično shemo za načrtovanje 
tiskanega vezaj.    

 

Slika 3. Shema za načrtovanje tiskanega vezja.  

 

11.2.2 Načrtovanje tiskanine  

Enako pomembno, kot izdelava sheme je naslednji korak izdelava tiskanine. 
Načrtovanje tiskanine zajemo postavitev elementov ter povezavo med njimi. Z izdelavo 
tiskanine določimo končni izgled tesanega vezja. Pri izdelavi tiskanine je zelo 
pomembno, da uporabljamo knjižnice elementov. V knjižnici elementov so zajete 
karakteristike in dimenzije elementa, kakor tudi imena priključnih sponk. Pri izdelavi 
tiskanine je potrebno upoštevati naslednja pravila:  

• Izbira tiskanine (material, debelina). 

• Število plasti tiskanine. 

• Razporeditev plasti. 

• Razporeditev vezij na tiskanini. 
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• Upoštevanje parazitnih vplivov. 

• Postavitev komponent na tiskanini. 
 

 

Slika 4.Tiskanina-PCB. 

 

Pri izdelavi tiskanih se pogosto uporabljajo različni metrični sistemi. Elektronske 
komponente imajo običajno dimenzije in razporeditev priključnih nogic predstavljene v 
colskih enotah. V Evropi se pogosteje uporabljajo metrične enote. Colsko enoto so 
pogosteje v uporabi za dimenzije povezav, bakrenih priključkov in blazinic. Metrične 
enote se uporabljajo za določanje dimenzije lukenj, velikosti tiskanine ter dimenzije 
ohišij vezja.  

 
Bakrene povezave 

Širino bakrene povezave izberemo glede na električne zahteve in prostora na tiskanini. 
Širše povezave nam dajo hitrejše odzive in boljše rezultate.  Širše in debelejše povezave 
imajo nižjo upornost in manjšo dolžino, njihova proizvodnja je enostavnejša in cenejša, 
lažje jih popravljamo in pregledujemo. Pri izbiri proizvajalca tiskanine se je potrebno 
pozanimati, kakšne so lahko najožje povezave, in najmanjši razmiki, ki jih še lahko 
proizvajalec zagotovi. 

 Na primer ponudba 10/8 pomeni, da so lahko povezave široke najmanj 10 mil, razdalja 
med njimi pa je lahko najmanj 8 mil. Tipična ponudbe so 10/10, 8/8. V splošnem velja, 
da lahko tiskanine z 12/12 izdela praktično vsak proizvajalec. IPC standard priporoča 
spodnjo mejo le do 4/4. Manjše razdalje lahko pomenijo tudi mnogo višje cene izdelave 
tiskanine. Zato je primer dobre prakse nameščanje tem širše povezave in jih stanjšati na 
mestih, kjer je to nujno (zoževanje), slika 5. Tako obdržimo nižjo skupno impedanco . 
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Slika 5.Primer zoževanja povezave. 

Debelino in dolžino žice določa tudi električni tok ter frekvenca električnega 
signala. Za višje tokove je priporočeno, da uporabimo čim debelejše povezave. Tanjše 
povezave imajo višjo upornost, kar povzroča izgube in nepotrebno gretje vodnika. 
Spodnja tabela 1. podaja priporočljivo debelino povezave glede na tok pri porastu 
temperature za 10 ˚C.   

 Preffered Line Width (mil) 1mil=0.0254mm 
Current [A] 1oz  Width (µm) 2oz Width (µm) 

1 350 175 
2 1050 525 
3 1750 875 
4 2800 1400 
5 3850 1925 
6 5250 2625 
7 6300 3150 
8 7700 3850 
9 9100 4550 

10 10500 5250 

Tabel 1.Debelina bakrene povezave na tiskanini glede na referenčni tok. 

Upornost bakrene žice je podana s: 

𝑅 =
𝜌𝐶𝑢𝑙

𝑆
,   𝜌𝐶𝑢 = 1.724 × 10−6Ω𝑐𝑚, 

 

kjer je 𝑅 upornost,  𝑙 dolžina, 𝑆 presek in 𝜌𝐶𝑢specifična upornost bakra. Dolžina 
povezave je pogojena s predvideno frekvenco signala. Primer dobre prakse podaja 
približno ocene dolžine povezave glede na frekvenco signala.  

𝐿 =
1

20
𝜆 =

1𝑐

20𝜐
 , 

Kjer je 𝐿 -dopustna dolžina povezave, 𝜆- valovna dolžina valovanja, 𝜐 – frekvenca 
valovanja, 𝑐- svetlobna hitrost. Pri visoko frekvenčnih signalih  pogaja ni moč izpolniti 
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zato je potrebno upoštevati čas propagacije signala po dani povezavi, saj ta vnaša 
časovno zakasnitev. Pri paralelnih vodilih je pomembno, da so paralelni vodi čim krajši 
ter enako dolgi. Večina programskih paketov opravlja korekcijo dolžin kritičnih vodov. 
Prav tako se pri visoko frekvenčnih povezavah izogibamo skoznjikov, saj ti povzročajo 
motnje ter izgubo signala. 

Skoznjiki  

Skoznjiki so metalizirane bakrene povezave med različnimi plastmi. Skoznjike v 
angleškem izrazoslovju poznamo kot 'VIA'. Skoznjiki so zelo podobni priključnim 
blazinicam, katerih ne smemo zamenjevati. Priključna blazinica je del podnožja 
komponente, skoznjik pa služi samo premostitvenim povezavam med različnimi plastmi 
tiskanine. Slika 6. prikazuje skoznjike pri več plastni tiskanini.  

 

Slika 6.Skoznjiki pri več plastni tiskanini. 

Poligoni 

Poligoni se uporabljajo za zapolnjevanje večjih površin s čistim bakrom ali bakreno 
teksturo, slika 7. Poligoni med sabo povezujejo priključne blazinice in skoznjike. Običajno 
se uporabljajo za nameščanje ozemljitvenih in napajalnih ploskev. Nameščamo jih na 
koncu, ko smo že izrisali vse druge bakrene povezave. 

 

a)                                                                                            b) 

Slika7. Poligon tiskanine; a) zgornja plast, b) bakrena tekstura. 

Pri umeščanju poligona ter povezav je potrebno biti pozoren na prazen prostor 
med povezavami ali poligonom. Premajhne razdalje niso zaželene, saj te lahko 
povzročajo kratke stike v obliki bakrenih las, ki lahko nastanejo v fazi izdelave tiskanine. 
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Upoštevati moramo tudi spodnjo mejo izvedbe tiskanine. To je odvisno od proizvajalca 
ter tehnologije izdelave. Velja naj pravilo 15 mil za žične komponente, 8 do 10 mil pa 
spodnja meja za elemente za površinsko montažo. Za vezja, ki delujejo na mrežni 
napetosti 230 V/110 V moramo upoštevati varnostne standarde, ki veljajo za določeno 
geografsko področje. Osnovno pravilo med faznim in nultim vodom mora biti razmak 
vsaj 3.2 mm. Najmanjša razdalja med visokonapetostnimi deli in deli s katerimi lahko 
pride v stik uporabnik je najmanj 8 mm. Preprost nasvet sledi, razmiki naj bodo raje večji, 
kot manjši toda še v okvirju želenih dimenzij!   

Pri dimenzijah je potrebno upoštevati tudi razdalje za galvansko ločitev. Te razdalje 
določa IPC standard. Razdalje se razlikujejo ali so znotraj ali zunaj tiskanine ter področja, 
kjer se bo elektronska komponenta uporabljala (vlažna okolja, nadmorska višina itd.. ). 
Pogosto tiskanine zaščitimo z lakirnimi premazi, ki povečajo galvansko trdnost ter ščitijo 
vezje pred zunanjimi vplivi. Tabela 2. podaja standardne razdalje povezave ter plasti za 
različne komponente tiskanega vezja, glede na nazivno napetost. Galvanska ločitev je 
določena s prebojno napetostjo.  Prebojna trdnost je lastnost materiala, ki je podana z 
naslednjim izrazom, 

𝐸𝑝 =
𝑈𝑝

𝑑
    [

𝑉

𝑚
], 

kjer je 𝐸𝑝  - električna prebojna trdnost, 𝑈𝑝 - električna napetost in 𝑑- debelina 

izolanta. Tako imajo različni izolanti različne električne prebojne trdnosti, predstavljeni 
v tabeli 3. 

Voltage Internal layers External conductors 
uncoated 

External conductors 
coated 

[V] [mm] [mm] [mm] 

15 0.05 0.1 0.05 
20 0.05 0.1 0.05 
50 0.1 0.6 0.13 

100 0.1 0.6 0.13 
150 0.2 0.6 0.4 
170 0.2 1.25 0.4 
250 0.2 1.25 0.4 
300 0.2 1.25 0.4 
500 0.25 2.5 0.8 

1000 1.5 5 2.33 
4000 9 20 11.48 
5000 11.5 25 11.53 

Tabel 2. Predpisane razdalje za galvansko ločitev povezav tiskanine.  

Isolant (20C̊) 
𝐸𝑝  [

𝑉

𝑚
] × 106 

Air 3 
Paper 10 

Pubber 10 
Transformer oil 15 

Porcelain 20 
Polyvinyl Chloride-PVC 50 

Polystyrol 80 

Tabel 3.Električna prebojna trdnost nekaterih materialov.  
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Osnovna pravila povezovanja komponent tiskanine 

Povezovanje komponent je nameščanje bakrenih povezav na tiskanino med 
priključki komponent. Električne povezave med dvema ali več priključnimi blazinicami 
imenujemo električna signalna mreža. Strmimo k tem krajšim električnim signalnim 
mrežam, daljše povezave prinesejo večje parazitne vplive. Povezave naj se lomijo s koti 
45° ali uporabljamo zaokrožene povezave. Bakrene povezave povezujemo na sredino 
priključnih blazinic, pomagamo si z delovno mrežo ali z funkcijo „snap to objects“ – sicer 
odvisno od programskega paketa. Povezavo med dvema točkama naj sestavlja le ena 
povezava. Za večje tokove je nujna uporaba večjih skoznjikov, kateri zmanjšajo 
impedanco in povečajo zanesljivost. Med priključnimi blazinicami na razdalji 100 mil 
zmanjšamo širino povezave. Napajalne in ozemljitvene povezave naj bodo čim širše, 
zaradi višje tokovne obremenitve. Napajalno in ozemljitveno povezavo speljemo čim 
bližje skupaj, kar lahko učinkovito blokiramo s kapacitivnimi elementi. Na tiskanini ne 
sme biti nepovezanih bakrenih otokov. Te otoke ozemljimo ali jih izbrišemo. Slika 8. 
ponazarja različne načine povezave elementov.   

 

                  a)                                                                         b)                                                    c) 

Slika 8. Povezave tiskanine; a) primerno, b) primerno, c) neprimerno. 

 

Izbira tiskanine 

Pri izbiri materiala za tiskanine imamo različne možnosti, saj le te ločijo po 
različnih karakteristikah kot so; požarna varnost, temperaturna stabilnost, absorpcija 
vlage. Te karakteristike so določene z mednarodnim združenjem NEMA –'National 
Electrical Manufacturers Association'. Tabel 4. podaja pregled materialov za izdelavo 
tiskanine.  
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Material  Comment 

FR-1 Bakelite: at room temperature poor moisture resistance. 
FR-2 Bakelite: suitable for single-layered PCBs, good moisture resistance. 
FR-3 Epoxy resins: a balanced material with good mechanical and 

electrical properties. 
FR-4 Glass fibers: excellent mechanical and electrical properties. 
FR-5 Glass fibers: high strength at high temperatures, self-extinguishing. 
G10 Woven glass and epoxy: high insulation resistance, maximum 

mechanical strength, high moisture resistance. 
G11 Woven glass and epoxy: resistant to bending at high temperatures, 

extreme solvent resistance. 
CEM-1 Cotton paper and epoxy. 
CEM-2 Cotton paper and epoxy. 
CEM-3 Non-woven and epoxy. 
CEM-4 Woven glass and epoxy. 
CEM-5 Woven glass and polyester. 
PTFE Pure - expensive, low dielectric loss, for high frequency applications, 

very low moisture absorption (0.01%), mechanically soft. Difficult to 
laminate, rarely used in multilayer applications. 

RF-35 Fiberglass-reinforced ceramics-filled PTFE. Relatively less expensive, 
good mechanical properties, good high-frequency properties. 

Alumina Ceramic: Hard, brittle, very expensive, very high performance, good 
thermal conductivity. 

Polyimide A high-temperature polymer: Expensive, high-performance, higher 
water absorption (0.4%). Can be used from cryogenic temperatures 
to over 260 °C. 

Tabel 4. Tipi materialov za tiskana vezja.  

Oznaka 'FR' pomeni negorljivi material ('Flame Retardant'). Debelina bakrene 
prevleke tiskanine standardno znaša 0.5oz(18 µm), 1oz(35 µm) in 2oz(70 µm). Obstajajo 
tudi druge, ki so redkeje v uporabi (12 µm) in (105 µm). Tiskanine z aluminijevim ali 
kovinskim jedrom imajo prevelo bakra tudi od 70µm do 400µm. Najpogosteje 
uporabljeni material tiskanine v industrijskih okoljih je FR-4. FR-4 je nekako optimalna 
izbira med ceno in kavzaliteto.  

Pri snovanju tiskanine izbiramo tudi števila plasti v tiskanini. Večje število plasti 
v tiskanini ponavadi viša proizvodnjo tiskanine, toda omogoča izvedbo manjših in 
odpornejših tiskanin.  

• Enostranska tiskanina: Primerna za enostavna nizkofrekvenčna vezja, 
slika 9. Uporaba cenejših materialov FR-2. Vezje je izdelano z mnogo 
mostiči. Takšna vezja imajo slabo odpornost na elektro-magnetne 
motnje. Načrtovanje kompleksnejših vezij na enoslojno PCB zahteva 
mnogo več truda in inovativnosti. Ponavadi se uporabljajo za pilotske 
naprave in zgodnja testiranja komponent. 

• Dvostranska tiskanina: Pogosto se uporablja material FR-4, slika 10. 
Vezje je enostavnejše za povezovanje. Če je le možno, se spodnja ploskev 
nameni ozemljitvi, ostale povezave ostanejo na zgornji strani. Prednosti 
ozemljitvene ravnine so; Poveča mehansko stabilnost tiskanine, 
zmanjšuje impedanco vseh ozemljitvenih povezav (zmanjšuje šum). Doda 
porazdeljeno kapacitivnost do vsake povezave na zgornji plasti, kar 
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pomaga preprečevati elektro-magnetne motnje. Ta deluje, kot ščit pred 
elektro-magnetnim šumom, katerega vir je lahko okolica tiskanine.  

• Večstranske tiskanine: Lahko se uporablja od 4,6,8,10… 38 plasti.  
Primernejše za občutljive visokofrekvenčne naprave. Običajna debelina 
2-slojne tiskanine je 1.5 mm, kar je preveč. Pri manjša razdalji med 
zgornjo in spodnjo plastjo dosežemo boljšo porazdeljeno kapacitivnost. 
Lažje povezovanje napajalnih in ozemljitvenih povezav (napajalne plasti 
in ozemljitvene plasti). Povezovanje je enostavno izvedeno preko  
skoznjikov. Ostale signalne linije imajo veliko prostora na vseh ostalih 
plasteh, kar močno poenostavi povezovanje. Večja porazdeljena 
kapacitivnost med močnostnimi in ozemljitvenimi plastmi, kar zmanjšuje 
visoko frekvenčni šum. Boljše blokiranje EMI/RFI. Izdelava večplastnih je 
bistveno držaj, kot manj plastnih ali eno plastnih vezij. 

 

Slika 9. Enostranska tiskanina. 

 

Slika 10. Dvostranska tiskanina. 
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Slika 11. Večplastna tiskanina. 

11.3. Primer uporabe programa Altium Designer 
 

Program Altium-Designer je profesionalno okolje za načrtovanje tiskanih vezij v 
vseh fazah kot so: 

• Načrtovanje diagramov potekov in blok diagramov. 

• Načrtovanje tiskanine-PCB. 

• Načrtovanje strojne opreme za FPGA 'Field Programmable Gate Array'. 

• Sistemske rešitve za FPGA in razhroščevanje “debugging” (pri delu z 
ustreznimi razvojnimi ploščami, kot je naprimer Altium NanoBoard). 

•  Načrtovanje vgrajenih sistemov. 

• Simulacijska orodja za digitalna in analogna vezja. 

•  Analize kvalitete signalov. 

•  Vodenje postopkov pri proizvodnji tiskanin. 
 

Altium vključuje urejevalnike in programske uporabniške vmesnike za vse korake 
načrtovanja elektronskih naprav. Pisanje in urejanje programske kode skupaj s 
prevajanjem se izvaja znotraj okolja Altium-Designer. V našem primeru  bomo večjo 
pozornost namenili risanju ter snovanju tiskanega vezja za elektronsko napravo. Vsebino 
smo zasnovali tako, da ponuja pregled nad različnimi fazami snovanja tiskanega vezja. 
Prva faza snovanja zajema izris električne sheme. Druga faza zajema prevajanja sheme 
v tiskano vezje. V tej fazi se določa, dimenzija tiskanine, postavitev elementov ter 
povezovanje. V tretji fazi bomo pokazali način predstavitve tiskanine v 3D okolju in 
možnost uporabe v ostalih CAD programih.  Za primer bomo vzeli vezje tokovnega 
generatorja, slika 12.  
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Slika 12. Shema tokovnega generatorja. 

 

 

11.3.1 Kreiranje novega projekta 

Za vsako novo tiskanino je priporočljivo ustvariti nov projekt, saj imamo v sklopu 
projekta shranjene vse dokumente in nastavitve, ki se navezujejo na načrtovanje. 
Projektna datoteda xxx.PrjPCB je ASCII datoteka, v kateri so zapisani vsi izhodni 
dokumenti in nastavitve, kot so npr. nastavitve za tiskanje in CAM. Dokumenti, ki pa niso 
povezani s projektom, se imenujejo prosti dokumenti. V projekt se dodajajo povezave 
na električne sheme, PCB, FPGA, vgradni VHDL ‘Verilog hardware description language’ 
in knjižnice. Ko enkrat projekt prevedemo ‘compile’ se vso načrtovanje sinhronizira 
znotraj dokumentov v projektu. Projekt kreiramo z naslednjim nizom ukazov: 

• Izberemo File -> New->Project->PCB Project, Slika 13. 

 

Slika 13. Kreiranje novega projekta. 

• Prikaže se okno Projects, kjer je naveden projekt PCB_Projects.PrjPcb 
brez dodanih dokumentov 
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• Poljubno preimenujemo projekt, v našem primeru v Tokovni_ 
generator.PrjPcb, tako da ga z naslednjimi ukazi shranimo na želeno 
lokacijo diska. File ->Save Project As -> Tokovni_generator.PrjPcb. 

 

Nato ustvarimo novo datoteko za načrtovanje električne sheme 'schematic'. 
Kreiramo novo shemo.  

• Izberemo File->New->Schematic. Prikažeta se datoteka z imenom 
Sheet1.SchDoc, ki je avtomatsko dodana/povezana z že ustvarjenim 
projektom, Slika 14  

• Shemo preimenujemo v Tokovni_generator.SchDoc. Shemo shranimo, File 
-> Save As ->Tokovni_generator.SchDoc. 
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Slika 14. Kreiranje sheme vezja. 

 

Ko se prazna shema odpre, lahko opazimo popolnoma spremenjen pogled z drugačnimi 
gumbi, menuji, it… Sedaj se nahajamo v urejevalniku za električne sheme. Če bi želeli k 
kreirani shemi dodati že izrisano shemo drugega projekta, preprosto izberemo  Add 
Existing to Project. 

 

Preden začnemo sestavljati električno shemo je potrebno nastaviti: 

• Nastavitev formata delovnega lista: Design->Document, Options… 
izberemo format lista A4. 

• Delovni list poljubno povečujemo s kombinacijo tipke CTRL + kolešček na 
miški; pogled lahko tudi prilagodimo celotnemu zaslonu z ukazom View-
>Fit Document [bližnjica: V, D]. 

• Nato je še ogromno nastavitev, do katerih dostopamo preko menuja 
Tools->Schematic Preferences [bližnjica: T, P], kjer bodo nastavitve 
vplivale na vse sheme pod delovnim projektom. 

• Kliknemo še na shemo in izberemo Default Primitives in omogočimo 
možnost Permanent, kar nam ob vnovični izbiri električnega elementa iz 
nabora knjižnice ponudi osnovne prednastavljene vrednosti in ne tiste, ki 
smo jih mi nastavili v prejšnjem koraku. 

 

Risanje sheme se začne z izbiro elementov slika 12. Glede na sliko 12, bomo v knjižnici 
elementov poiskali vse elemente slike 12, začenši z operacijskim ojačevalnikom MCP602. 
Altium ima zelo močno podporo knjižnic električnih komponent kot so; sheme, podnožja 
in 3D modeli. Če knjižnice še niso nameščene, si jih lahko ob veljavni licenci zastonj 
naložimo iz Altiumove spletne strani https://designcontent.live.altium.com/. Prav tako 
si lahko naložimo še vedno prosto dostopne knjižnice iz leta 2004 ter si jih razširimo v 
mapo, kjer imamo že inštalirane osnovne knjižnice od Altiuma. 

Da poiščemo pravi ojačevalnik MCP602, kliknemo na Libraries in nato na Search, 
(ali kliknemo na Tools>>Find Components), da se nam odpre Libraries Search dialog. 

https://designcontent.live.altium.com/
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 Paziti moramo, da imamo izbrane komponente in da iščemo v načinu 'Libraries on path', 
kjer moramo imeti vpisano pravilno pot nameščenih knjižnic. Za večjo možnost zadetka 
pri iskanju ne vpišemo vseh znakov, ampak samo tiste osrednje, kajti različni proizvajalci 
imajo drugačne pripone in predpone. To vpišemo tako, da iskalni niz vpišemo med dve 
zvezdici (v našem primeru: *602*). Če bi iz ponujenega seznama izbrali komponento, ki 
še ni nameščena, bi dobili možnost potrditve, da jo lahko nemudoma namestimo, kar 
lahko nato v nadaljevanju izberemo. Za MC602 je potrebno predhodno namestiti 
knjižnico od proizvajalca Microchip ('Microchip Linear Devices.IntLib'), nakar je MCP602 
na voljo in ga lahko izberemo, slika 15. 

 

   
Slika 15. Izbira MCP602 iz knjižnice. 

 

Vstavljanje izvedemo tako, da dvakrat kliknemo na želeno komponento, kar nam 
omogoči da s kazalcem ponesemo element v delovno okolje. Preden ga vstavimo na 
določeno mesto, mu lahko uredimo oznake in lastnosti, kar omogočimo s pritiskom na 
tipko tabulator. Nato v polju 'Designator' (ime elementa) vpišemo oznako komponente, 
ki jo bomo videli na shemi (v našem primeru: U1A). Pri modelu preverimo ali ima 
komponenta pravilno podnožje ( v našem primeru je SMD SOIC – 8 priključkov). Ko smo 
nastavili vse potrebno, lahko pričnemo z vstavljanjem komponent v shemo. 
Komponento postavimo v želen položaj s klikom ali pritiskom na ENTER. Nato kazalnik 
premaknemo in vidimo, da lahko z naslednjim klikom vstavimo še drugi OPA, ki se mu 
oznaka U1A avtomatsko poveča na U1B, ostale pred-nastavljene lastnosti pa ostanejo 
nespremenjene. Okolje Altium omogoča mnogokratnik vstavljanja komponent istega 
tipa, katero zaključimo s pritiskom na tipko ESC. 
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V naslednjem koraku bomo vstavili 7 uporov. Za vstavljanje uporov bomo uporabili 
osnovno knjižnico, ki je že nameščena v Altium okolju 'Miscellaneous Devices.IntLib'. V 
iskalnik vpišemo *Res* ter nato izberemo upor s podnožjem SMD tipa 2010, ki ga 
najdemo označenega kot Res3. Vrednost izberemo 25k (teh imamo največ), ki jo lahko 
pri posameznih uporih kasneje tudi spremenimo. 'Designator' ponovno nastavimo na 
najnižjo vrednost R1 in pričnemo z vnašanjem, kot v prejšnjem primeru. Dva upora nato 
preimenujemo v Rref in Rb, tako da kliknemo na vsakega posamezno in jima 
spremenimo ime v polju 'Designator', slika 16. 

   
Slika 16. Izbira upora iz knjižnice. 

Podobno postopamo še z elementi napetostni stabilizator LM336 (2.5V, ohišje 
TO92) iz knjižnice ST-Electronics 'Power Mgt Voltage Reference.IntLib', kondenzatorji 
(iskani niz *Cap*) in priključnimi sponkami (iskani niz *Header*), ki se nahajajo v knjižnici 
'Miscellaneous Devices.IntLib', slika 17. 

 
Slika 17. Izbira LM336, kondenzatorjev ter priključnih sponk. 
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Komponente pravilno razvrstimo po shemi in upoštevamo pravilo, vhodi na levi in 
izhodi na desni strani. Paziti je potrebno, da je med komponentami dovolj prostora za 
povezave, kajti v primeru če potegnemo električno povezavo preko priključnih nožic, jo 
bo program avtomatsko povezal s prekrižanim priključkom, slika 18.  

 

 
Slika 18. Razporeditev elementov. 

 

 

K obstoječim komponentam je potrebno dodati še ustrezne napetostne 

potenciale, kot so ničla – ozemljitve  in napajanje . Mi bomo za naše potrebe vstavili 
GND in napajanja Vdd (vstavljamo jih na več mestih, da ohranjamo boljšo preglednost 
sheme). Pri povezovanju moramo upoštevati naslednja pravila: 

 

• Imeti moramo dober pogled na celotno shemo. 

• Povezave rišemo z orodjem  'Place Wire' [bližnjica: P,W]. Bodimo 
pozorni na spoje pri prepletanju povezav, da na primer po nepotrebnem 
ne naredimo kratkega stika. 

•  Če želimo premikati komponente potem, ko smo te že povezali lahko to 
storimo tako, da izbrišemo trenutne povezave, komponente premaknemo 
in jih nato ponovno povežemo. Lahko pa uporabimo kombinacijo 
CTRL+premikanje z miško, kar omogoča premikanje komponent skupaj z že 
narejenimi povezavami. 

 

Dokončano vezalno shemo predstavlja slika 19. 
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Slika 19. Shema tokovnega generatorja. 

 

V semho je smiselno dodati tudi imena posameznih povezav 'Nets and Net Labels', 
ki jih lahko nadalje uporabimo na tiskanini. Imena povezav niso ključna za delovanje 
vezja, ampak služijo kot opomba ali referenca pri pregledu končnega vezja ali poznejšem 
popravilu. Priključki komponent so povezani s povezavami ‘Nets’ Pomembnejše 
povezave in potenciale v električni shemi lahko poimenujemo s poljubnimi imeni. Z 
uporabo simbola za GND in Vdd smo že avtomatsko določili dve imeni. Z izbiro menu-
>Place->Net Label [bližnjica: P, N] dobimo možnost, da lahko določimo ime poljubni 
povezavi. S pritiskom na TAB lahko posežemo v nastavitve, kot so barva, postavitev in 
tip pisave za ‘Net Label’, še preden definiramo kateri povezavi bomo dodelili novo ime, 
slika 20. 

 
Slika 20. Okno za nastavitev imena povezave, tip pisave, barva, velikost. 

 

Pri našem vezju bomo ime povezave uporabili za referenčno napetost Vref, slika 21. 
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Slika 21. Določeno ime povezave Vref . 

 

S tem smo zaključili risanje in oblikovanje električne sheme, kar je osnova, da 
preidemo na načrtovanje tiskanega vezja. Preden začnemo s prevajanjem sheme v 
tiskanino, je priporočljivo še konfigurirati nastavitve projekta. Nastavitve projekta 
vključujejo nastavitve odkrivanja napak, matriko povezav, generiranje razredov, 
nastavitve primerjalnika, generiranje opozorilnih sporočil, pred-nastavitve tiskanja,… 
vse te nastavitve Altium uporabi pri prevajanju projekta. Ko je projekt preveden se 
preveri celovita zasnova in električna pravila, ki so bila zastavljena. Potem, ko so vse 
napake odpravljene, se ponovno prevedena shema naloži v ciljni projekt kot je npr. PCB 
dokument. Primerjalnik projekta omogoča iskanje razlik med izvorom in ciljnimi 
datotekami, ki jih vidimo in jih lahko potrdimo ali zavrnemo (sinhroniziramo) v obeh 
smereh. Vse nastavitve so nam na voljo pod menijem Project->Project Options. 

 

11.3.2 Določitev tiskanine 

Po dokončani vezalnih shemi ter nastavitvi pravi lahko začnemo s prevajanjem 
vezalne sheme v tiskanino. V fazi prevajanja projekta se preverijo vsa pravila načrtovanja 
elektronske sheme z možnim sledenjem napak in možnostjo popravljanja. Da 
prevedemo dan projekt Tokovni_generator.PrjPcb moramo izbrati Project->Compile 
PCB Project.. Ko je prevajanje končano lahko, se poročilo prevajalnika pojavi v 
sporočilnem oknu. Do okna dostopamo preko View -> Workspace Panels -> System-> 
Messages. Prevedeni dokumenti bodo zavedeni v oknu View->Workspace Panels-
>Design Compiler->Navigator, kjer lahko spremljamo strukturo dokumentov, seznam 
komponent in vrsto povezav (ob kliku na povezavo, se nam le ta s poudarjenimi črtami 
prikaže na shemi ). Prav tako v primeru napak in neuspešnega prevajanja se le ta beležijo 
v oknu za napake 'Error Messages'. Če je prevajanje uspešno se premaknemo v nov 
dokument v katerem načrtamo tiskanino dani električni shemi. Na začetku kreiramo 
prazen PCB. Najlažji način je z uporabo vmesnika 'PCB Board Wizard' s katerim lahko 
izbiramo med industrijsko standardiziranimi formati ali lastnimi dimenzijami. Vedno 
lahko kasneje te nastavitve še spremenimo. 'PCB Board Wizard' najdemo pod menujem 
'Files', ki ga moramo imeti omogočenega pri pogledu, da ga lahko nato izberemo kot 
prikazuje slika 22. Če izbor file ni omogočen, desno na dnu sheme imamo vrstico bližnjic 
do nekaterih funkcij in pod zavihkom 'System' obkljukamo zavihek 'Files'.  
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Slika 22. Izbira bližnjice  do 'Files' . 

 

Postopek priprave dokumenta je sledeč 

 

1. Najprej kliknemo na 'PCB Board Wizard', kjer v drugem oknu izbiramo metrične 
enote 'Metric', slika 23. 

    
Slika 22. Okno čarovnika za kreiranje tiskanine PCB. 

  

2. V tretjem oknu izbiramo med želenimi formati PCB-ja. Lahko izberemo po meri 
'Custom' ter nato vpišemo dimenzije W=40 mm, H=30 mm. Za označbo roba 
PCB-ja naj bo izbrana vrsta črte 'Mechanical Layer1'. 

3. V naslednjih dveh oknu izberemo število plasti in vrsto skoznjikov, dvoplastna 
tiskanina, in skoznjiki, ki gredo skozi celotno debelino PCB-ja. 

4. Nato izberemo kakšno vrste komponent bomo v večini nameščali na PCB (SMD, 
PDIP … glede na podnožje) ter na koliko straneh. Večina površinskih komponent 
'Surface-mount components' in nameščanje samo na eni strani. 
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5. V naslednjem zadnjem oknu izberemo priporočene nastavitve za povezave in 
skoznjike: 

a. Najmanjša debelina povezave = 0,25 mm 

b. Najmanjša širina skoznjikov = 1 mm 

c. Najmanjši premer luknje skoznjikov = 0,6 mm 

d. Najmanjši razmik med povezavami = 0,25 mm 

 

Slika 23., prikazuje okna čarovnika za nastavitev tiskanine.  

 

 

 

 

Slika 23. Koraki nastavitve tiskanine od 2-5. 

 

Po uspešnem kreiranju  tiskanine se nam prikaže okno tiskanine z izbranimi 
dimenzijami. Da nimamo v ozadju bele podlage lista, ga v nastavitvah odstranimo, 
Design->Board Options…, kjer odkljukamo 'Display Sheet'. Pogled PCB-ja prilagodimo 
zaslonu z ukazom View-> Fit Board oz. bližnjico [V,F], slika 24. 
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a)                                                                                            b) 

Slika 24. Prilagoditev pogleda tiskanine z 'a)'  in odstranjenim ozadjem 'b)'. 

 

Dimenzije PCB-ja lahko kasneje poljubno spremenimo. Najenostavneje je da v PCB-
ju narišemo želeno obliko okvirja, katera nato uporabimo za določitev mej PCB-ja. To 
storimo tako, da z  miško izberemo vse črte, ki naj bi določale robove PCB-ja in nato z 
funkcijo, do katere dostopamo preko menuja Desing->Board Shape->Define from 
selected objects, obrežemo PCB na želeno poljubno obliko, slika 24. 

 

Slika 24. Poljubna oblika PCB-ja. 

 

11.3.3 Prevajanje projekta - 'Compiling' 

Najprej se postavimo v okolje el. sheme ter jo prevedemo:  Design->Update PCB. 
Kliknemo na Validate Changes, kjer se preveri možnost napak. Če je vse v redu, se pod 
statusom izrišejo potrditvene kljukice. Če vse spremembe niso pravilne, se moramo 
vrniti nazaj, preveriti sporočila napak in napake odpraviti. Ko naposled preverjanje uspe, 
kliknemo na Execute Changes, kar izvede prenos komponent in povezav na PCB shranjen 
v projektu, slika 25. 
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Slika 25.Preverjanje sheme pred prevajanjem. 

 

Prenos komponent na tiskanino PCB, slika 26. 

 

Slika 26.Oblika elementov za tiskanino. 

Glede na sliko 26. je razvidno, da je postavitev elementov na tiskanino prepuščeno 
snovalcu. V tem primeru je smiselno upoštevati napotke in navodila dobrega snovanja 
tiskanin.  V naslednjem koraku sledi postavitev komponent na tiskanino. Komponente 
razmeščamo tako, da kliknemo na posamezno komponento in jo prenesemo v pravilen 
položaj (kliknemo z levim gumbom, ki ga nato držimo dokler prestavljamo komponento). 
Držimo se zastavljenih mej PCB-ja. S preslednico lahko med prenašanjem rotiramo 
komponento. Tekst, ki se navezuje na komponente lahko poljubno prestavljamo na enak 
način, kot komponente. 

 

Slika 27.Razvrščene komponente na tiskanini. 
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Okolje Altium ima podporo funkcij za lažje razmeščanje komponent. Več 
komponent lahko poravnavamo glede na horizontalno in vertikalno smer,  ozirom na 
različne robove ali središčnice. Poravnavamo jih lahko tudi z enakomernim razmikom. 
Do teh funkcij dostopamo tako, da izberemo skupino komponent, kjer si pomagamo s 
tipko SHIFT, ali enostavno zaokrožimo želene komponente. Nato kliknemo z desnim 
gumbom miške in izberemo Align->Align… [bližnjica: A, A] in označimo želene funkcije 
po X in po Y osi. Prav tako, ko označimo eno ali več komponent skupaj, jih lahko skupaj 
premikamo z miško ali pa uporabimo kombinacijo tipk: CTRL, SHIFT in smerne tipke. Tako 
na primer kombinacija smerne tipke in CTRL povzroči manjši premik (snap grid x 1) v 
želeni smeri, če pa skupaj držimo obe tipki CTRL+SHIFT, se bo ob pritisku na smerno tipko 
skupina komponent premaknila za večji razdelek (snap grid x 10) v želeni smeri.  

Povezovanje postavljenih elementov lahko izvedemo ročno ali uporabimo 
avtomatsko povezovanje. Pri ročnem povezovanju imamo več pregleda na povezavami 
in je delo zamudnejše. Ročno povezovanje se pogosteje uporablja pri večjih tiskaninah. 
Avtomatsko povezovanje je praviloma uporabnejše pri preprostih vezjih. 

 

Ročno povezovanje tiskanine PCB 

Ročno povezovanje PCB pomeni ročno vstavljanje povezav in skoznjikov na 
tiskanino, da med sabo povežemo vse komponente, kot to narekuje električna shema. V 
ročnem načinu se ponavadi načrtujejo zahtevnejše tiskanine, kjer so pomembni mnogi 
vidiki načrtovanja kot so vpliv EMI, dizajniranje RF vezij, kombinirana analogna in 
digitalna vezja, kombninirana močnostna elektronika in digitalna/analogna vezja, itd 
Mnogokrat se mora načrtovalec odločati in sprejemati kompromise med posameznimi 
deli načrtovanja. 

V našem primeru bomo kljub enostavnosti vezja, le to najprej povezali ročno. 
Signalne povezave bomo skušali v tem večji meri izrisati na zgornji strani 'Top layer', 
spodnjo plast pa bomo uporabili za maso GND, do katere bomo dostopali s skoznjiki in 
v nekaterih primerih s priključnimi blazinicami (konektorji P1 in P2 ter referenca – U3). 
Povezave so sestavljene iz zaporednih ravnih segmentov. Ob vsaki spremembi smeri se 
začne nov segment povezave. V osnovi nam Altium omogoča postavitev povezav v 
vertikalni, horizontalni in pod kotom 45 ° (pri naprednih nastavitvah lahko uporabljamo 
tudi krivulje), da dobimo lep profesionalen končni videz. 

Mi bomo uporabljali standardne nastavitve. Najprej bomo izbrali pogled 'Top Layer'. 
Uporabimo bližnjico L, da pridemo v menu 'View Configuration' , kjer odstranimo 
kljukico pri Bottom Layer in spremembo potrdimo, slika 28. 

 
Slika 28. Izbira zgornje plasti tiskanine. 
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Povezovanje pričnemo s . Povezujemo lahko le tiste komponente oz. priključke, ki so 
med sabo električno povezani v shemi, kar nam v PCB okolju nakazujejo tanke ravne črte 
med priključnimi blazinicami. S pritiskom na tipko CTRL in klikom na določeno priključno 
blazinico lahko enostavno preverimo katere blazinice so povezane skupaj. Ko vlečemo 
povezavo med dvema priključkoma, jo lahko zaključimo tudi s pomočjo avtomatske 
funkcije 'Auto-complete'. To storimo tako, da kliknemo na prvi priključek in nato še na 
drugi, pri tem pa držimo CTRL in smerno tipko '->' med priključkoma se bo povezava 
kreirala sama po najkrajši poti. Ta funkcija je uspešna, če je pot dokaj enostavna brez 
večjih ovir med točkama. Drugi način je z uporabo tipke ENTER, kjer povezave 
zaključujemo postopoma, s čimer tudi zmanjšamo število segmentov ene povezave med 
dvema priključkoma. Altium omogoča tudi različne načine ročnega povezovanja, kjer 
med vlečenjem povezave s pritiskom na SHIFT + R lahko izbiramo med raznimi metodami 
kot so: 

• 'Push' - v tem načinu se bo povezava skušala prebiti do druge točke s 
premikanjem že postavljenih povezav in skoznjikov v mejah pravil. 

• 'Walkaround' - pot do druge točke skuša najti tako, da se povezava riše okoli ovir, 
brez premikanja obstoječih povezav in skoznjikov. 

• 'Hug & Push' - ta način je kombinacija prejšnjih dveh. 
• 'Ignore' - Ta metoda dovoljuje postavitev povezav kjerkoli, ne glede na kršitve 

pravil. 

Pozorni moramo biti tudi na komponente, ki jih nameščamo na zgornji površini, 
kjer so nameščene signalne povezave in tistimi, ki imajo priključne blazinice speljane 
skozi PCB na drugo stran. Komponente, ki imajo priključne blazinice speljane skozi PCB  
se namreč spajkajo na drugi strani. V našem primeru se te komponente spajkajo spodaj, 
zato jih moramo s signalnimi povezavami na zgornji strani povezati s skoznjiki. Skoznjike 

najdemo med gumbi z imenom 'Place Via' . Z ozirom na to, da bomo spodnjo plast 
uporabili za maso, bomo skoznjike namestili ob konektorjih P1 in P2 ter ob referenci. 

Poleg vseh komponent in skoznjikov, je dobro predvideti tudi kako se bo PCB 
pritrdil na ohišje, torej ponavadi je dobro predvideti kakšne luknje za vijake. Le te 

ustvarimo tako, da iz orodne vrstice izberemo gumb 'Place Pad'  in ga nastavimo tako, 
da ga ne povežemo z nobeno električno povezavo in odkljukamo opcijo 'Plated', da nam 
ne dela kasneje težav (javljanje napak) pri preverjanju PCB-ja.  

Slika 29. Povezana tiskanina 
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Sedaj je potrebno samo še spodnjo stran tiskanine zaliti z maso (GND). To storimo tako, 

da iz orodne vrstice izberemo gumb  'Place Polygon Plane', mu nastavimo lastnosti 
ter nato definiramo meje poligona tako, da jih narišemo na PCB, slika 30 in 31. 

 
Slika 29. Določitev poligona za maso na spodnjem strani tiskanine. 

 

Slika 30. Tiskanina z dodano maso-GND na spodnji strani. 

Avtomatsko povezovanje - 'Auto Routing' 

Preprostejše in manj zahtevne PCB lahko povezujemo v avtomatskem režimu, 
kjer se vse izvaja striktno upoštevajoč vsa pravila. V našem primeru želimo imeti 
signalne linije na zgornji strani in spodnjo stran PCB-ja rezervirano za GND poligon. 
Zato moramo nastavitve prilagoditi, da se bo povezovalo samo na zgornji strani.  To 
storimo med pravili. Design->Rules…, kjer pod 'Routing Layers' omogočimo le 'Top 
Layer', slika 31. Nato v menuju izberemo Auto Route->All in kliknemo na 'Route All'. 

 
Slika 31. Izbira zgornje plasti za avtomatsko povezovanje povezav med komponentami. 
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 Slika 32. Rezultat avtomatskega povezovanja. 

Rezultat je na videz podoben, vendar so detajli, ki smo jih v ročnem režimu naredili 
bolje. Tako je na tej tiskanini kar nekaj napak, ki jih lahko hitro spregledamo. Upoštevano 
ni, da imajo komponente, ki se spajkajo na spodnji strani, le na spodnji strani električni 
kontakt, zato jih je potrebno preko skoznjikov povezati s povezavami na zgornji strani. 
Skoznjiki so dobrodošli tudi pri GND povezavah, da GND povezave naredimo tem krajše. 
Če povezujemo avtomatsko, je smiselno uporabljati skupine povezav ‘Net Classes’. Te 
nastavimo preko uporabniškega vmesnika Design->Classes… Kjer dodamo skupine tako, 
da gremo s kurzorjem na zavihek Net Classes in s pomočjo desnega gumba izberemo 
možnost 'Add Class'. Pridemo v okno, kjer se nam v stolpcu 'Non-Members' izpišejo vse 
električne povezave, ki so na voljo, na desni strani pa je prostor kamor s klikom na 
puščico dodajamo želene/označene povezave. 

  

 

 

Slika 32. Dodajanje skupine povezav. 
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3D pogled tiskanine 

3D pogled omogoča, da lahko PCB pogledamo v prostoru iz katerekoli perspektive. 

Med pogledi se prestavljamo s številkami 1, 2 in 3. Številka '3' je bližnjica za 3D pogled, 

slika 33. 

 

Slika 33. 3D pogled tiskanine. 

 
V 3D pogledu si lahko pomagamo z naslednjimi bližnjicami: 

• Povečevanje: CTRL + kolešček miške 

• Premiki gor/dol: kolešček miške, Premiki levo/desno: SHIFT+kolešček miške 

• Vrtenje: SHIFT + desni stisk gumba na miški in vlečemo v želeni smeri, ki jo 

izberemo na krogli s puščicami. 

Altium ponuja uvoz 3D objektov iz raznih CAD orodij v *.step* formatu. Možno je 

tudi izvoziti PCB v formatih kot so: step, dwg/dxf. Izvožene objekte je možno uporabiti 

v drugih CAD programih, ki podpirajo omenjene formate.  

 

Končna dokumentacija 

Končno ali izhodno dokumentacijo razdelimo v 5 skupin: 

 
1. Kosovnice 

a. Načrti za avtomatizirano robotsko postavitev komponent. 

b. Načrti postavitve komponent na obeh straneh PCB. 

2. Izhodna dokumentacija 

a. Načrti komponent vključno z bakrenimi povezavami. 

b. 3D pogledi PCB. 

c. Shematski prikaz električnih vezij. 

3. Dokumentacija za proizvodnjo tiskanine 

a. 'Composite Drill Drawings' -načrti lukenj, njihove pozicije in velikosti, 
vse na enem načrtu. 

b. 'Drill Drawing/Guides' -načrti lukenj in navodila za izdelavo, njihove 
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pozicije in velikosti v ločenih risbah. 

c. 'Final Artwork Prints'- v enem načrtu zajeta množica različnih izhodnih 
informacij. 

d. 'Gerber Files' -Gerber datoteke, izdelane za vsako plast PCB posebej. 

e. 'NC Drill Files' -za numerično krimiljenje (CNC) vrtalnih strojev. 

f. 'ODB++' Kreiranje baz za proizvajalca v ODB++ formatu, bazira na C++. 

g. 'Power-Plane Prints'- načrti notranjih in ločenih plasti 

h. 'Solder/Paste Mask Prints'-načrti zaščitnih plasti 

i. 'Test Point Report'-Poročilo o testnih točkah 

4. 'Netlist Outputs' Seznami povezav 

a. Seznami navajajo logično povezovanje med priključki komponent (v 

različnih tekstovni formatih, CSV ('coma separated values') 

5. Izhodna poročila 

a. 'Bill of Materials' -seznam materiala, ki ga potrebujemo za izdelavo 
električnega vezja. 

b. 'Component Cross Reference Report'- seznam komponent na osnovi el. 
sheme. 

c. 'Report Project Hierarchy' -seznam vseh dokumentov. 

d. 'Report Single Pin Nets' -seznam povezav, ki imajo le en priključek. 

 
 
Dokumentacija za potrebe proizvodnje 

 
V zadnji fazi moramo proizvajalcu PCB dostaviti vse potrebne dokumente, da lahko nato 
izdela temu primeren in želen PCB. V ta namen je potrebno poslati 'Gerber' in 'NC Drill' 
datoteke ter seznam materiala. 
 
Shranjevanje Gerber datotek- Vsaka gerber datoteka pripada eni fizični plasti tiskanine 
z vsemi možnimi črtnimi profili ('Component overlay', 'signal layers', 'solder masking 
layers', itd). Pred pošiljanjem in shranjevanjem  Gerber datotek, pa se je priporočljivo 
posvetovati s proizvajalcem, da se poenotimo z njihovimi zahtevami. 

 

 
 


